Compatibility mode

rev. 0.1, 10/09/2015
Index

1 COMPATIBILITY MODE FOR DUPLINE® ................................................................. 4
  1.1 How to enable the Dupline compatibility in the Sx tool .................................. 5
  1.2 How to manage the Dupline network in a Sx2WEB24 system ....................... 6
      1.2.1 How to import a .scc file generated by the BH8-CTRLX-230 configuration tool  6
      1.2.2 How to import Locations and Dupline modules ................................ 7
      1.2.3 How to manually add the modules .................................................. 11
      1.2.4 Dupline module addressing ........................................................... 13
      1.2.5 How to change the proposed addresses ......................................... 13
      1.2.6 How to check the Dupline address listing ..................................... 14

2 FUNCTIONS AND SIGNALS .................................................................................. 16
  2.1 How to set a Dupline: dimmable light function .......................................... 18
      2.1.1 How to dim a light with input commands ...................................... 19
      2.1.2 How to set the signal properties ................................................... 20
      2.1.3 How to select a dimmable output .................................................. 21
      2.1.4 How to set a signal as feedback of the status of the dimmer function .......... 22
      2.1.5 How to force the output OFF ......................................................... 23
      2.1.6 How to set predefined scenarios with input signals ....................... 23
      2.1.7 How to manage lights automatically .............................................. 26
      2.1.8 How to select a PIR sensor to control Scenarios ................................ 26
      2.1.9 How to turn a light ON with PIR sensors, and turn it OFF manually ......... 27
      2.1.10 How to change scenario with a PIR ............................................. 28
      2.1.11 How to turn a light ON with PIR sensors, and turn it OFF automatically . . . 28
      2.1.12 How to switch the light ON manually and OFF with the PIR sensor .... 29
      2.1.13 How to switch the light on and off according to the lux sensor ............ 30
      2.1.14 How to switch the light on/off using the Real time signals (Calendar) ....... 32
      2.1.15 How to dim the light with a Function status ................................... 33
      2.1.16 Definitions table ........................................................................... 34
  2.2 How to set a Dupline: Rollerblinds function .............................................. 38
      2.2.1 How to move blinds Up/Down using a manual input ......................... 39
      2.2.2 How to select and configure the output for motor up ....................... 41
      2.2.3 How to select and configure the output for motor down .................. 42
      2.2.4 How to set the running time for Motor output .................................. 43
      2.2.5 How to manage rollerblinds with automations .................................. 44
      2.2.6 How to use the wind sensor to control blinds .................................. 44
      2.2.7 How to control the blind according to the lux meter ....................... 47
      2.2.8 How to move the blinds Up/Down with Real time signals (Calendar) ...... 49
  2.3 How to set a Dupline: Window control function .......................................... 51
  2.4 How to set a Dupline: Digital thermostat function ....................................... 52
      2.4.1 How to add a Thermostat signal .................................................... 52
      2.4.2 How to enable the Night setback mode ......................................... 53
      2.4.3 How to force heating OFF ............................................................... 54
      2.4.4 How to add the Output signals ....................................................... 54
      2.4.5 How to set the Heat ON LED as a feedback signal ........................ 55
      2.4.6 How to use the calendar for night setback .................................... 56
  2.5 How to set a Dupline: Temperature regulation function ............................. 57
      2.5.1 How to add a temperature signal .................................................... 57
      2.5.2 How to use the Temperature function with a temperature display ........ 58
      2.5.3 How to set the working mode ......................................................... 58
      2.5.4 How to enable the visualization of the external temperature in the Bxx-TEMDIS display .... 61

Compatibility mode – Sx tool manual
2.5.5 How to add the Heating/Cooling control ................................................................. 62
2.5.6 How to add the Heating output ............................................................................... 62
2.5.7 How to force Heating/Cooling OFF ....................................................................... 63
2.5.8 How to enable the night mode .................................................................................. 64
2.5.9 How to configure the setpoint for comfort mode .................................................... 64
2.5.10 How to configure the setpoint for Night setback / economy mode ..................... 65
2.5.11 How to set the antifreeze temperature ................................................................... 66
2.5.12 How to set the Heat safety ...................................................................................... 67
1 Compatibility mode for Dupline®

The master channel generator SH2DUG24 provides the channel generator output drive for a Dupline® network in a smart-Dupline® system, which is controlled by the Sx2WEB24. Together with an Sx2WEB24, it substitutes a BH8-CTRLX-230, a BH8-CTRLZ-230, a G3800xxxx, G3890xxxx master generator or a G3490xxx channel generator.

Each Sx2WEB24 can be connected up to 7 master channel generators (the sum of SH2MCG24, SH2DUG24 and SH2WBU230 is 7) in order to have 7 Dupline® and smart Dupline® networks. All the devices are connected via an internal bus if they are in the same cabinet, or via terminals if they are mounted in different cabinets. Each SH2DUG24 must have an address that is programmed by using the Sx tool.

The Sx tool is able to read the .scc file created by means of the BH8-CTRLX-230 configuration software and import the modules list with the relevant channel addressing and locations tree. Functions have to be created from scratch.

What cannot be imported from a BH8-CTRLX-230 configuration to a Sx2WEB24 one:
- **Constant light:** should this be present in a BH8-CTRLX-230 system, it has to be substituted with a smart-dupline one
- **Tilting feature in the rollerblind function:** should this be present in a BH8-CTRLX-230 system, it has to be substituted with a smart-dupline one
- **Touch screen software:** should this be present in a BH8-CTRLX-230 system, it has to be substituted with a BTM-Tx-24 one
1.1 How to enable the Dupline compatibility in the Sx tool

The user has to enable the Dupline compatibility in the Sx tool in order to fully manage a Dupline® network in a smart-Dupline® system.

In the Program setup menu, the user has to click on the System setup icon (see picture below).

![System setup icon](image)

The Setup system properties window will appear as shown in the picture below: all the settings configured here will be available in all the new projects, without the need to repeat this operation every time.

![Setup system properties](image)

In the bottom of the Advanced settings field, the user has to enable the Dupline compatibility by selecting the green V icon. Once selected, the software has to be closed and then opened again to enable it.

The Sx tool starts running with the standard Dupline support: new functions will be available that can manage those modules not powered by smart-Dupline.
1.2 How to manage the Dupline network in a Sx2WEB24 system

The user has to disconnect and replace a BH8-CTRLX-230, a BH8-CTRLZ-230, or a G3800xxxx, G3890xxxx master generator with a Sx2WEB24 controller together with a SH2DUG24 Dupline generator. The BH8-CTRLX-230 controller can be connected to up to 3 bus extension modules: for each bus extension module, a SH2DUG24 Dupline generator must be used to replace it. Then, the user has to import the .scc file generated by the BH8-CTRLX-230 configuration tool: the Dupline modules, channels and locations are imported automatically and the user has to add manually only the functions. The modules can also be added manually without importing them and the Sx tool will suggest a channel assignment that can be changed by the user at any time. Since standard Dupline needs channels to be programmed, each module has to be programmed by means of the BGP-COD-BAT.

1.2.1 How to import a .scc file generated by the BH8-CTRLX-230 configuration tool

One of the main points of the Dupline compatibility feature is the possibility of importing a project from an existing installation powered by a BH8-CTRLX-230, a BH8-CTRLZ-230 or a G3800xxxx, G3890xxxx Dupline controller.

Please refer to the Dupline Hardware manual for the wiring diagram and technical instructions.

The user then has to import the .scc file generated by the BH8-CTRLX-230 configuration tool.

In the File menu of the Sx tool by clicking on the Import .scc file button, the user opens a 'Find' dialogue window that allows him to choose the required project file.

The user can browse the directory and select the project to import.

After having selected the correct file, the Sx tool automatically starts the conversion into the new file extension.

Compatibility mode – Sx tool manual
1.2.2 How to import Locations and Dupline modules

In the *Location selection* window, the user has to select which locations he wants to import into the project. The Locations are organized in a tree structure: it is possible to select one or more floors and the rooms required. See the example shown in the picture below.
In the Module selection window the user has to select which modules he wants to import into the project. After having selected them, press Confirm.

In the Module selection window, there are only the Dupline modules that are present in the location selected in the Location selection window.

Example
The picture below shows the import of an .scc file with three Dupline buses. The Dupline Bus 0 is shown in the red rectangle, the Dupline Bus 1 is shown in the green rectangle and the Dupline Bus 2 is shown in the blue rectangle. Each Dupline module is shown with its Dupline bus association.
Click on the Close button to close the Configuration Download dialog box once the importing process is finished.

The imported project is now available in the Sx tool: the tree of the locations has been imported and it is shown in the Locations view of the Sx tool (see the red rectangle below) together with the relevant links.

All the Dupline modules imported from the .scc project file are shown in the Modules view of the Sx tool (see the green rectangle in the picture above) with the same channel coding as in the original project.
If the installation has more than one Dupline bus, the user must be sure to assign the correct subnetwork to each SH2DUG24 module according to the network it is connected to: to do this, from the *Modules* window, click on the icons marked in red, as shown in the picture below:

The following window will appear where only the SH2DUG24 Dupline generator is shown in order to simplify the association.

By clicking on the required module, the association is carried out.

**N.B.** All the other Dupline modules will not be found by the *Modules discovery*, since they are not powered by smart-Dupline capabilities.

**N.B.** The discovery is available if an Sx2WEB24 system is connected to the Sx tool, otherwise the SIN number of the SH2DUG24 has to be added manually.
1.2.3 How to manually add the modules

When the user creates the project without using the Import .scc file procedure, the first thing to do is to add and configure the SH2DUG24 Dupline master generator and then add all the Dupline modules, selecting the subnetwork they belong to.

To add a Dupline generator the user should select Bus generators from the Add menu, then select Dupline generator (see picture below). The new module will be added into the selected location.

The wizard relevant to a Dupline generator can also be opened by typing Alt+F7. (See table of short cuts).

In the picture above, a new Dupline generator is inserted with its associated new network (e.g. Dup 1 shown in the red rectangle).

Each added SH2DUG24 will be assigned to a new sub-network, up to 7 Master generator/Master generator wireless. The first SH2DUG24 added will be assigned to the sub-network 1 (Dup 1), the second one to sub-network 2 (Dup 2) and so on until all the Dupline generators are added.
If the project has more than one SH2DUG24 Dupline generator, the user must be sure to assign the correct sub-network to each Dupline module according to the network it is connected to: to do this, press the triple arrow button (see picture below) highlighted with a red rectangle. If Confirm is pressed, the module is added to the sub-network 1 (Dup 1) by default.

The selection of the network is made by choosing the correct one in the Subnet field, as marked in red in the picture below.

N.B. If a module is entered with a wrong Subnet, the user must delete it and add it again.
1.2.4 Dupline module addressing

For each Dupline module being added in a new project, the Sx tool suggests an automatic coding of all the I/O channels which the installer can change at any time if they do not suit. The Sx tool also avoids addressing two signals with the same channel and suggests channels association without any gap in order not to waste them.

1.2.5 How to change the proposed addresses

The user can change the suggested addresses manually, opening the wizard of the module by clicking on the relevant pictures in the Modules window.

As shown below, in the Input signals field of the module window, the user can assign the Dupline channel manually in the field marked with a red rectangle, selecting any available address in the list, as shown in the green rectangle. The input channels already assigned are shown in blue.
In the *Output signals* field of the module window, the user can assign the *Dupline channel* manually in the field marked with a red rectangle, selecting any available address in the list, as shown in the green rectangle. The output channels already assigned are shown in blue.

1.2.6 How to check the Dupline address listing

When the project is created, all the modules are to be programmed according to the address list shown in *Dupline: modules report*.

In the *Reports* menu, the user has to click on the *Dupline: Modules report* icon (see picture below).
The *Dupline: Modules report* will appear showing the list of channels:

For each module present in the project, the list of associated channels is shown.
2 Functions and signals

The digital input signals coming from the Dupline modules can be used in all the functions. The digital output signals coming from the LEDs and the relays can also be used in all the functions. The analink signals can also be used in all the functions.

The signals coming from dimmer modules, rollerblind modules, temdis and temthe modules have to be used in the special compatibility functions that are very similar to those of the BH8-CTRLX-230 controller: they cannot be used in the smart-Dupline functions.

These five functions

- **Dupline: dimmable light**
- **Dupline: Rollerblinds and Dupline: Window control**
- **Dupline: Temperature regulation and Dupline: Digital thermostat**

appear in the Sx tool when the **Compatibility** feature is enabled.

In all the functions, a mix of smart-Dupline and Dupline signals can be used, with the exceptions explained below.

<table>
<thead>
<tr>
<th>Sx tool Function</th>
<th>Digital Input</th>
<th>Digital Output</th>
<th>Analog Input</th>
<th>Analog Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
</tr>
<tr>
<td>Dimmable light</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td>Dupline Smart Dupline</td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Constant light</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td>Dupline Smart Dupline</td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Dupline: Dimmable light</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>Rollerblinds</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td>Dupline Smart Dupline</td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Tilting blinds</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td>Dupline Smart Dupline</td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Open/close window</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td>Dupline Smart Dupline</td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Dupline: Rollerblind</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>Dupline: Window control</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>Zone temperature</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Heating temperature system</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>Cooling temperature system</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>Dupline: temperature regulation</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>Dupline (Only TEMDIS)</td>
<td>/</td>
</tr>
<tr>
<td>Dupline: digital thermostat</td>
<td>Dupline Smart Dupline</td>
<td>Dupline Smart Dupline</td>
<td>/</td>
<td>/</td>
</tr>
</tbody>
</table>

Compatibility mode – Sx tool manual
<table>
<thead>
<tr>
<th>Feature</th>
<th>Dupline</th>
<th>Smart Dupline</th>
<th>Dupline</th>
<th>Smart Dupline</th>
<th>Dupline</th>
<th>Smart Dupline</th>
<th>Dupline</th>
<th>Smart Dupline</th>
<th>Dupline</th>
<th>Smart Dupline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone intruder alarm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Main intruder alarm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smoke alarm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Water alarm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Siren alarm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sequence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimmer sequence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay timer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recycling timer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interval timer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Counter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Multigate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analogue comparator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Mathematical function</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Analogue output</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Smart Dupline</td>
</tr>
<tr>
<td>Hour counting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Simulated habitation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sms setup</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Car heating</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2.1 How to set a **Dupline: dimmable light function**

This function allows the installer to manage one Dupline dimmer output from the following modules: BH4-D230W2-230, BH4-500W-230, SH2D500W230, BH6-D500W2-230, BH4-D10V2-230 or G42484134. This **Dupline: dimmable light** function is the same as the **Dimmable light** function available in the BH8-CTRLX-230 configuration tool.

The user can either configure a basic function to switch the light on/off and adjust the light intensity, or implement an automated system, by programming the relevant objects of the function by using the **Advanced** section.

To set up a dimmable light function the user should select **Light & Scenario** from the Add menu, then select **Dupline: Dimmable Light** (see picture below). The new function will be added into the selected location.

This function can manage only one dimmer output, controlled by one or more input commands. The command might be a real signal such as a pushbutton, a function or a remote command (Webserver, sms, email, Modbus TCP/IP).

The automation of the **Dupline: dimmable light** function is managed by accessing the **Advanced** section (see picture below).

In the **Advanced** section the user can select different ways of controlling the dimmable light: according to the ambient light, the presence of people, with timers and/or schedulers. Up to 4 different predefined scenarios can be set (for the G42484134 dimmer module up to 6 scenarios can be set).
2.1.1 How to dim a light with input commands

First, the user has to add the input signals to control the dimmable light in the On/off input signals field. The input signal can be a pushbutton or a switch and can manage both the On/Off switching and the light level adjustments: a short click of the switch toggles the light on or off, and a long press dims the light up and down. The user should select the one required, then double click on it and add the input signal from the list.
2.1.2 How to set the signal properties

The light is switched On/Off with a short click (input active for a period shorter than 1 second). When the light is on, by keeping the input active for more than 1 second (see the Long activation(s) field in the yellow rectangle), the light level starts going up/down.

Each time the light reaches the maximum/minimum level, the ramp is inverted. In the Signal properties window, the user can also check the Dupline channel of each added signal (See the yellow rectangle in the picture below).
2.1.3 How to select a dimmable output

To select the output signal that is controlled by the *Dupline: dimmable light* function, click on *Controlled output* and then double click on the Signals window. Once the output window is opened, select the relevant outputs from the list.

The signals available in the output window are only standard Dupline dimmer signals. For each dimmer output, four signals are used: the user just needs to check one and immediately the other three will be added automatically.
2.1.4 How to set a signal as feedback of the status of the dimmer function

To select the feedback signal that indicates the status of the function, click on Feedback signals and then double click on the Signals window.

The signals available in this window are LEDs and relays. Up to 50 signals can be chosen and they will be managed in parallel. The logic of each feedback signal can be set as normal or inverted (see the yellow rectangle).
2.1.5 How to force the output OFF

If the user wants to stop the automation regardless of all other signals used in the function, the Automation override field has to be used: to enable it, select Automation override in the Advanced section, then double click on the signal window and select the right signal. A level signal has to be selected, such as a toggle switch or a function.

Each signal used in the Automation override, when active, stops the automation. Until the signal is active, the light is forced to the off status; when the signal is non-active, the light returns to the previous status.

2.1.6 How to set predefined scenarios with input signals

In this section, the user can customize different scenarios and select different input signals to activate them. There are two scenarios that are not editable (Scenario 5 and Scenario 6 are reserved for the G42484134 dimmer module only). Here the user can only set the signals that activate them. Each scenario can be activated manually by adding an input signal in the Signals window, or it can also be activated by different automations such as PIR sensors, functions or Calendars.

The first thing to do to use different Scenarios is to enable them in the Advanced section. The user should go to the Advanced steps of the function and then check Scene selection. The user can select the scenario from the list, then with a double click in the signals field, he can add one or more inputs to activate the Scenario.
The light is switched On with a short press (input activated and deactivated within 1 sec). When the light is on, by keeping the input active for more than 1 second, the light level will start going Up/Down until the input signal is active. In the Signals window, the user can also enable the reversing of each added signal.

2.1.6.1 Scenario 1 (20%).

In the Scenario 1 (20%) window the user can add an input signal with a double click on the Signal window and then select the input from the list of available signals.

In the example above, the user has set one pushbutton for the manual activation of Scenario 1 (20%). Each time pushbutton 2 is activated with a short press, the light level will be set to 20%.
2.1.6.2 Scenario 2 (40%)

The light is switched On with a short press (input activated and deactivated within 1 sec). In the Signals window, the user can also enable the reversing of each added signal.

In the Scenario 2 (40%) window the user can add an input signal with a double click on the Signals window and then select the input from the list of available signals.

In the example above, the user has set one pushbutton for the manual activation of Scenario 2 (40%). The output dimming percentage is set to 40%. Each time pushbutton 3 is activated with a short press, the light level will be set to 40%.

2.1.6.3 Scenario 3 (60%)

This scenario is managed in the same way as the previous scenarios.

2.1.6.4 Scenario 4 (80%)

This scenario is managed in the same way as the previous scenarios.

2.1.6.5 Scenario 5 and Scenario 6

These Scenarios are reserved for the G42484134 dimmer module only.
2.1.7 How to manage lights automatically

The automatic on/off switching of the light can be managed by PIR sensors (the light will be switched ON when the PIR sensor detects people movement), by Real time signals (calendar to switch the light on/off at pre-defined time intervals) or by lux meters which switch the light on/off according to the level of ambient light.

All these automations can be enabled in the Advanced section.

2.1.8 How to select a PIR sensor to control Scenarios

The motion detector sensor can be used to perform different functions:

- switching the light on, on movement detection.
- adjusting the light level to a predefined value.
- switching the light off if no movement is detected within a set time interval.

The first thing to do when a PIR sensor needs to be used in a Dupline: dimmable light function is to enable it in the Advanced section.

The Motion detectors menu will appear. After selecting this, with a double click on the Signals window the list of available signals will appear.

Select the required signal/signals and click on Confirm. Up to 50 signals can be selected and the system will perform a logical OR of all of them.
Once the PIR sensor is added, the user can also choose to invert the signal by selecting the green V below Inverted signal, in the Signals Setting tab window.

2.1.9 How to turn a light ON with PIR sensors, and turn it OFF manually

In order to create this easy automation, the user must select at least one input signal for the manual command, one output signal to control the load and then a PIR sensor in the Advanced section. In this case the light will not be switched OFF automatically if no presence is detected, so the energy-save timer must not be used in the Advanced section.

Once the PIR signal is entered, the user should select the green “V” in the option Pir switches on (see the red rectangle in the picture below). In this way, each time the PIR detects movement, the light will automatically go to ON. The user can also select the light percentage value of the output when the PIR detects movement and switches the light ON.
2.1.10 How to change scenario with a PIR

The user should select the green “V” in the option *Use auto scenarios* to use two different light levels: each time the PIR detects movement, the light will automatically be switched to the light level defined in the field *Scenario 2 (%)*; when the PIR does not detect any movement in the corridor and the energy save timer has expired, the light goes to the light level set in *Scenario 1 (%)*. 

![Image of PIR settings]

In the example above, the PIR is set to switch the light ON at 80% when it detects movement and sets it to 20% when it does not detect any movement.

2.1.11 How to turn a light ON with PIR sensors, and turn it OFF automatically

The energy-save timer must be set in order to turn the dimmable light OFF when the timer expires.

An example of this automation could be in a corridor: when a person enters the corridor, the light is switched on and the energy-save timer starts counting: when it expires, the light is switched off.

The first step is to add the output signal, then to add a PIR sensor with the option *Pir switches on* enabled, and then to set an energy-save timer to switch the light off automatically when no movement is detected. To set an energy-save timer, select *Motion detectors* then select *Energy save timer* from the *Advanced* section, change the timing by moving the slider or typing hours, minutes and seconds, then press *Confirm*. The energy-save timer starts counting when no presence is detected. Each time presence is detected the timer is reloaded. When the timer expires, the light is switched off.
In the picture above the energy save timer is configured to turn the dimmable light OFF 10 minutes after the PIR stops detecting presence.

2.1.12 How to switch the light ON manually and OFF with the PIR sensor

An example of this automation is an office where the employees sometimes forget to switch the light off when they leave the office. When the PIR stops detecting presence in the office, the energy-save timer starts counting and when it expires, the light is turned off.

If the user wants to use the PIR sensor to switch the light off automatically, the following settings should be used. Add a PIR sensor and an energy-save timer from the Advanced section. In the Motion detectors window the red cross in the Pir switches on and Use auto scenarios fields must be unchecked because the light has to be switched on manually.

The energy-save timer must be set differently from zero, and will be triggered when the light is switched on. While the PIR detects movement, the timer is reloaded. When the PIR stops detecting movement, the timer starts counting down and when it expires the light is switched off accordingly.
In the picture above the energy save timer is configured to turn the dimmable light OFF 15 minutes after the PIR stop detecting movement.

2.1.13 How to switch the light on and off according to the lux sensor

An example of this automation could be an outdoor light that has to be switched on at sunset and stay on during the night.

To create this kind of automation, lux meters have to be used: the user can set a threshold value so that the smart-house system switches the light ON when the measured daylight goes below this threshold, and switches the light OFF when the daylight goes above this threshold.

Since this is an Advanced functionality, the Luxsensor field has to be enabled in the Advanced section. The Luxsensor menu will appear. After selecting this, with a double click on the Signals window the list of available signals will appear. Select the required signal/signals and click on Confirm.
The user can add up to ten lux sensors: if more lux signals are linked to the function, the average lux value is calculated and then used. Once a lux sensor is selected, the user can change the settings as shown in the picture below:

*Lux level on (Lux)*
When the light level goes below the threshold, the light goes ON. The user has to set the light level threshold by filling in the *Lux level on* field.

*Lux level off (Lux)*
When the light level goes above the threshold, the light goes OFF. The user has to set the light level threshold by filling in the *Lux level off* field.

The ON and OFF switching is done in the event of the thresholds being surpassed, so if the light status is changed manually by means of a light switch or automatically, e.g. by a scheduler, the automation of the lux sensors will not change it unless thresholds are surpassed another time.
2.1.14 How to switch the light on/off using the Real time signals (Calendar)

An example of this automation could be a Real time signals (Calendar) that switches all lights off at a pre-set time in the night. If the function uses an energy-save timer, the Real time signals (Calendar) does not affect it. Before using a global calendar, the user should define it as a function (See How to set a global calendar in the Sx Tool manual by clicking on Real time signals and then double clicking in the Signals window to select the required Real time signals function.

In the example below, the global calendar added is a calendar generated for switching on all the lights at a pre-set time.

N.B. To control the Dupline: dimmable light function with a Real time signals (Calendar), the user has to create a Calendar function and has to select the green V Use this calendar for command and disable signals, as shown in the picture below:

To set the Global calendar function, please read paragraph How to set a global calendar function in the Sx tool manual.
2.1.15 How to dim the light with a Function status

An example of this automation could be the change of the *Dupline: Dimmable light* status according to the output status of another function. If this function uses an energy-save timer, the function status does not affect it in anyway.

The *Functions* field has to be selected in the *Advanced* menu. By clicking on *Functions* and then double clicking in the *Signals* window, select *Functions* status.

A generic *Light* function can be linked to the *Dupline: Dimmable light* status in order to change the dimmer output status according to its status: when the generic function status is ON, the *Dupline: Dimmable light* goes ON at Scenario1, when the generic function status is OFF, the dimmer output goes OFF.
2.1.16 Definitions table

Table of light dimmer function combinations:

Control with button and PIR
Control with button & PIR - Automatic scenarios

Control with button, Lux and PIR

Control with button, Lux and PIR - Automatic scenarios

Control with button, Lux and RTC

Compatibility mode – Sx tool manual
Control with button, Lux and RTC – Automatic scenarios

Control with button, RTC & PIR
Control with button, RTC, Lux & PIR

Control with button, RTC, Lux & PIR - Automatic scenarios
2.2 How to set a **Dupline: Rollerblinds** function

The user can either configure a basic function to move blinds up and down, or implement an automated system by programming the relevant objects of the function. To set up this kind of function, the user should select *Up and down control* from the Add menu, then select *Dupline: Rollerblinds* (see picture below). The new function will be added into the selected location.

![Function selection](image)

Like the legacy function present in the BH8-CTRLX-230 configuration tool, this function manages only one motor output controlled by one or more input commands. The command might be a physical signal like a pushbutton, a switch, a function or a remote command (Webserver, sms, Modbus TCP/IP). The automation of the blinds can be managed by accessing the *Advanced* section, where the user can select different kinds of automation: wind sensors, lux sensors or Real time signals (Calendar).
2.2.1 How to move blinds Up/Down using a manual input

The user should add the input signals to control the Up/Down movement of the blinds. To add the Up/Down signal, the user has to click on the relevant section, then double click on the Signals window and select the input signal from the list (see picture below). The input signal may be a pushbutton, a switch or a level signal.

Once the Up/Down signal is entered, the user can also choose to use the inverted logic of the signal (see yellow rectangle in the picture below).

All the signals selected in the Up/Down window work in parallel (OR level).
According to the release time of the signal, the output can behave in two ways:

1. Once a pushbutton is pressed, the motor is activated for the time it needs to go fully Up/Down. When the button is pressed again, the motor is stopped.
   
   In the figure below, an example of the activation of the input signal and Controlled output is shown.

2. Once a pushbutton is pressed, the motor is activated for the time it needs to go fully Up/Down. When a pushbutton for the opposite direction is pressed, the motor is stopped for the time set in the Reverses motor time field, then reverses its direction and will go up/down for the whole Running UP/DOWN time (fully Up/Down).
2.2.1 How to select and configure the output for motor up

To select the output signal for motor up, which is controlled by the Dupline: Rollerblinds function, the user has to click on Controlled output and then double click on the Output for motor up signal window. Once the output window is opened, select the relevant motor output from the list.

The signals available in this window are only the standard Dupline motor output type (BH4-RO5A2-230, BH4-RO5ADC2-230). **Only one motor output can be selected.**
2.2.2 How to select and configure the output for motor down

To select the output signal for motor down, which is controlled by the Dupline: Rollerblinds function, the user has to click on Controlled output and then double click on the Output for motor down signal window. Once the output window is opened, select the relevant motor output from the list.

The signals available in this window are only the standard Dupline motor output type. Only one motor output can be selected.
2.2.3 How to set the running time for Motor output

The running and reverse times of the motor have to be set when the rollerblind module is added. These settings are needed for the correct operation of the function and they have to be defined in the wizard relevant to the Dupline: Rollerblinds function.

To access this, the user has to open the Dupline: Rollerblinds function window and then select Options (see picture below).

Reverse motor time (seconds):
This is the time in seconds to change the motor direction (this time should be set to 1 second at least, to avoid damaging the motor).

Running UP time (Minutes and Seconds):
This is the time for the blinds to go from a fully down position to a fully up position. Starting from a fully open position, the user must use the manual command to completely close the blind. The entire running time must be measured: the accuracy of the time is to 1 second.
Running DOWN time (Minutes and Seconds):
This is the time for the blinds to go from a fully up position to a fully down position. Starting from a fully wrapped position, the user must use the manual command to completely open the blind. The entire running time must be measured: the accuracy of the time is to 1 second.

2.2.4 How to manage rollerblinds with automations

The automatic up/down adjustment of the blinds can be managed by wind sensors (the speed value measured by the sensor can be used to adjust the blinds up/down), by the Real time signals function (Calendar to adjust up/down at pre-defined time intervals) or by lux meters moving blinds up/down according to the levels of ambient light. All these automation have to be enabled in the Advanced section.

2.2.5 How to use the wind sensor to control blinds

The wind sensor can be used to bring blinds into a safety position (useful if the user has a sunblind over his terrace) if the measured wind speed is very high or to make the blinds go down if the wind is calm.

When a wind sensor needs to be used, it must first be enabled in the Advanced section. The Wind sensors menu will appear. After selecting this, with a double click on the Signal window the list of available signals will appear. Select the required signal and click on Confirm. Only one signal can be selected.
Once the wind sensor is added, the user has to set the wind speed limits in the *Wind speed* menu:

In the *Down when <* field the user can select a wind threshold - when the wind speed goes below this threshold, the blinds totally open automatically (the totally-open position is fully down according to the settings in the output of the function).

In the *Up when >* field the user can select a wind threshold - when the wind speed goes over this threshold, the blinds are automatically brought into the safety position (the safety position is fully up according to the settings in the output of the function).

In the *For at least* fields the user can select a delay time to move the blind to fully down or to the safety position: the blind will be moved only when the wind condition is active for a time longer than this set value. If the delay time is set to 0 seconds, the delay time is disabled.

The Up and Down movement can be enabled/disabled separately by the *Enable* checkbox.
Example 1
In the picture below, when the wind speed goes below 3 m/s for more than 2 minutes, the blind is moved to the fully Down position.

Example 2
In the picture below, when the wind speed goes over 5 m/s for more than 1 minute, the blind is moved to the safety position.
2.2.6 How to control the blind according to the lux meter

The blind position can be managed in an automatic way by using the lux meter: the user can define up to two light thresholds to make the Sx2WEB24 system move the blinds up/down. To select the lux sensor, the user has to click on the **Luxsensor** field and then double click on the Signals window. Once the output window is opened, select the relevant signal from the list.

Once the lux sensor is added, the user can change the threshold values and the action that the blind has to perform when these values are reached in the **Luxsensor settings** window.

The up/down movements start when the thresholds are surpassed, so if the blind position is changed manually by means of a light switch or automatically e.g. by the calendar, the automation of the lux sensor will not change it unless the thresholds are surpassed.
In the *Lux level up (lux)* field the user can select a lux threshold - when the light goes below this threshold, the blinds are automatically open (the totally open position is according to the settings in the output of the function).

In the *Lux level down (lux)* field the user can select a lux threshold - when the light goes over this threshold, the blinds are totally closed automatically (the totally closed position is according to the settings in the output of the function).

The user can also set a cloud filter to prevent the up/down movements if a cloud shields the sun for a short time. We suggest setting the time for at least 60 seconds; if the time is set to 0 the filter is disabled.

**Example**
The picture below shows how the blind position is changed according to the light level: the *Lux level up (lux)* threshold is set to 1000 Lux and the *Lux level down (lux)* threshold is set to 3500 Lux: the cloud filter is disabled. When the light goes below 1000 Lux, the blind is moved to the fully Up position. When the light goes over 3500 Lux, the blind is moved to the fully Down position.
2.2.7 How to move the blinds Up/Down with Real time signals (Calendar)

An example of this automation could be to use the Real time signals (calendar) to move the blinds Up or Down at a certain hour, e.g. at ten o’clock in the evening.

To control the Dupline: Rollerblinds function with the Real time signals (Calendar), the user has to create a Calendar function and then select the green V Use this calendar for command and disable signals, as shown in the picture below:

To set the Global calendar function, please read paragraph How to set a global calendar function in the Sx tool manual.

The Real time signals (Calendar) field has to be selected in the Advanced menu and then double click in the Signals window to select the calendar function.
Example
One example is to use a calendar function set to work all year round (from 1st January to 31st December). The working days are: Monday, Tuesday, Wednesday, Thursday and Friday (the calendar does not work on Saturday and Sunday).
The start time is 7:30 and the stop time is 20:30.
At 7:30 the blind starts moving up. At 20:30 the blind starts moving down.
2.3 How to set a **Dupline: Window control** function

To set up this function, the user should select *Up and down control* from the *Add* menu, then select *Dupline: Window control* (see picture below). The new function will be added into the selected location.

The *Dupline: window control* function is similar to the *Dupline: Rollerblinds* function as described in the previous section.

The difference between the two functions are:

- **The temperature sensor is used instead of the lux-meter**
  
  The temperature sensor makes the windows open if the temperature rises above the *Temperature open* value, and close when the temperature falls below the *Temperature close* value.

- **The use of the Rain sensor**
  
  When a rain sensor is active (because of rain falling on it) the windows will close.
2.4 How to set a Dupline: Digital thermostat function

The Dupline: Digital thermostat function has been developed only for the standard Dupline BxW-TEMTHE module.

The BxW-TEMTHE is a module with one built-in temperature sensor, a manually adjustable set-point with a rotary control and a LED for indication.

To set up a Dupline: Digital thermostat function, the user has to select Temperature from the Add menu, then select Dupline: Digital thermostat function.

2.4.1 How to add a Thermostat signal

To add the Thermostat signal, the user has to click on the Thermostat signals field in the wizard menu of the function, then double click on the Signals window and select the signal from the Dupline BxW-TEMTHE module.
2.4.2 How to enable the Night setback mode

The *Night setback signals* field allows the temperature regulation to work in energy saving mode. This is used to control the room temperature with a predefined setpoint of 4°C lower than the normal setpoint. The user cannot change this offset value.

If the user wants to use the Night setback setpoint in the function, the *Night setback signals* field has to be used: to enable this, select *Night setback signals* in the wizard menu of the function, then double click on the Signals window and select the signal from the Dupline BxW-TEMTHE module.

![Screenshot of the Night setback signals window in the Sx tool manual.](image)

The *Night setback signals* works as a level signal. Until the signal is active, the Night setback setpoint is active.
2.4.3 How to force heating OFF

If the user wants to force the deactivation of the Output signals regardless of all the other signals used in the function, the Stop signals field has to be used: to enable this, select Stop signals in the wizard menu section, then double click on the Signals window and select the signal to use (see picture below).

![Image of wizard steps showing Stop signals field and available mode]

Each signal used in the Stop signals window works as a level signal. Until the signal is active, the output is forced off.

2.4.4 How to add the Output signals

To add the Output signals the user should click on the Output signals field in the wizard menu then double click on the Signals window and select the signal from the list of those available (see picture below):

![Image of wizard steps showing Output signals field and available mode]
The logic of each output signal can be set as normal or inverted (see the yellow rectangle in the picture below).

2.4.5 How to set the Heat ON LED as a feedback signal

The onboard red LED can be used to give information about the status of the Dupline: Digital thermostat function. It follows the status of the function: it is on if the function is on, and off if the function is off.

To manage the feedback LED, the user should click on the Output signals field in the wizard of the function, then double click on the Signals window and select the LED signal from the list of those available.
The signals available in this window are LEDs and relays and we suggest using the dedicated red LED present on the BxW-TEMTHE module. Up to 50 signals can also be used as feedback status signals and they can be managed in parallel.

The logic of each feedback signal can be set as normal or inverted (see yellow rectangle in the picture below).

2.4.6 How to use the calendar for night setback

The Calendar must be created before using the calendar function. To set the Global calendar function, please read paragraph How to set a global calendar function in the Sx tool manual.

To add the Calendar function, the user has to click on the Signals for night setback field in the wizard menu then double click on the Signals window and select the Calendar function from the list of those available (see picture below).
2.5 How to set a *Dupline: Temperature regulation* function

To set up a *Dupline: Temperature regulation* function, the user has to select *Temperature* from the *Add* menu, then select *Dupline: Temperature regulation*.

**Note:** The *Dupline: Temperature regulation* function is also available in the webserver and in the *Live signals* window in the Sx tool. When the configuration is uploaded into the Sx2WEB24, the temperature value takes up to 5 minutes to be shown.

2.5.1 How to add a temperature signal

In the first step of the function, the user must enter the temperature signal that has to be used to control heating/cooling. The available signals are from sensors such as Bxx-TEMANA, Bxx-TEMDIS.

If only the room temperature signal is used, the fields *Temperature options* and *Outdoor temperature sensor* are not managed.

Compatibility mode – Sx tool manual
2.5.2 How to use the Temperature function with a temperature display

In the Temperature sensors field, the user can add one temperature signal from a TEMDIS module (Bxx-TEMDIS). The signal is called Temp dat 1.

Note: Temp dat is a special data used by the system to transmit the Troom and Tfloor values, so in the Live signals window only Troom and Tfloor are shown.

2.5.3 How to set the working mode

In the Temperature options window, the user should select the relevant working mode of the temperature function, as shown in the picture below.

2.5.3.1 Room Temperature

The function regulates only according to the room temperature (T-room measured by Bxx-TEMDIS). In the Temperature options field, the user has to select the first icon on the left, as shown in the picture below.
2.5.3.2 Floor Temperature

The user shall select this working mode when the temperature regulation has to be done according to the floor temperature (usually this is the probe that is often placed in the floor to monitor the temperature in the heating tubes).

In the Temperature options field, the user has to select the second icon on the left, as shown in the picture below.

![Image of Temperature options](image)

The user can set two different thresholds: the Floor min temperature (°C) to allow a minimum floor temperature and the Floor max temperature (°C) in order to avoid over-heating of the floor.
2.5.3.3 Room Temperature with floor monitor

The function regulates according to the room temperature (T-room measured by Bxx-TEMDIS) but monitoring the floor temperature in order to avoid over-heating of the floor and to maintain a minimum temperature on the floor.

In the Temperature options field, the user has to select the third icon, as shown in the picture below.

![Temperature options](image)

The user can set two different thresholds: the Floor min temperature (°C) to allow a minimum floor temperature and the Floor max temperature (°C) in order to avoid over-heating of the floor.
2.5.4 How to enable the visualization of the external temperature in the Bxx-TEMDIS display

To add the external temperature signal, the user has to select the relevant section in the wizard of the function, then double click on the Signals window and select the input signal from the list of those available (see picture below).

In the Outdoor temperature signals window, the user can add one temperature signal from the sensor modules (e.g. BSI-TEMANA). This gives the possibility to show the outdoor temperature in the Bxx-TEMDIS display.
2.5.5 How to add the Heating/Cooling control

In the Advanced options of the wizard, the user shall set the heating/cooling parameters. By enabling Heating control, the relevant fields will appear (see picture below).

The settings of the Cooling control are the same as the Heating control.

2.5.6 How to add the Heating output

To add the Heating output signals the user shall click on the Heating output field in the Advanced section, then double click on the Signals window and select the signal from the list of those available (see picture below).
The logic of each output signal can be set as normal or inverted (see the yellow rectangle).

2.5.7 How to force Heating/Cooling OFF

If the user wants to force the deactivation of the Heating/Cooling outputs regardless of all the other signals used in the function, the Off signal field has to be used: to enable it, select Off signals in the Advanced section, then double click on the Signals window and select the signal to use (see picture below).

Each signal used in the Off signals window works as a level signal. Until the signal is active, the Heating/Cooling output is forced Off.
2.5.8 How to enable the night mode

The Night setback signals allow the temperature regulation to work in energy saving mode. Each signal used in this field works as a level signal: while the signal is active, the regulating setpoint is the one set in Night setback signals.

2.5.9 How to configure the setpoint for comfort mode

To change the predefined setpoints, the user shall click on the Options field in the Advanced section.

The user can select the operating range for the comfort setpoint. The temperatures chosen in the Min setpoint (°C) and Max setpoint (°C) fields are the setpoint limits between which the setpoint can be changed.

In the Temperature setpoint (°C) field, the user has to set the desired one for the comfort mode.
2.5.10 How to configure the setpoint for Night setback / economy mode

To change the predefined Night setback value, the user shall click on the Options field in the Advanced section of the function.

The user can select the operating range for the economy setpoint. The temperatures chosen in the Night setback min value (°C) and Night setback max value (°C) fields are the setpoint limits between which the setpoint can be changed.

In the Night setback (°C) field the user has to set the desired value for the economy mode.
2.5.11 How to set the antifreeze temperature

In the *Options* window of the function, the user can set the *Antifreeze* value. If the function status is set to OFF (the function status is Off), and the measured temperature in the function falls below the antifreeze value, the output in the zone is activated until the temperature is once again above the antifreeze limit.

The antifreeze regulation works with a hysteresis of one degree:

- **Heating ON** ➔ temperature < antifreeze temperature
- **Heating OFF** ➔ temperature ≥ antifreeze temperature
2.5.12 How to set the Heat safety

The safe condition can be set in order to keep the system in a safe working mode in case of a fault in the regulating temperature probe. The user shall choose different actions to be performed for Heating and Cooling. To configure the safe mode settings, the user has to click on the relevant field \textit{Heat safety} of the function wizard (see picture below).

The heat safety function will protect from overheating, in case of a sensor breakdown. As soon as this fault is detected, the system will make the regulating output cycle according to the setting in the \textit{Heating output percentage on sensor fail}, so that a minimum temperature is always maintained avoiding over-heating and preventing the house from freezing.

\textbf{N.B. The Heat safely function is active when a signal is added in the 'Heat output' field}

The user has to consider very thoroughly which value to put here; if set is too high, the room might be overheated.

\textit{Example}

The cycle time of the regulator is 100 seconds, when the Heat safety is active. If the value of the \textit{Heating output percentage on sensor fail} is set to 21\%, the ON time will be 21 seconds of the full 100 seconds cycle time. The rest 79 seconds, the output will be OFF.